
D9 Konštitutívne rovnice hyperelastického materiálu 

      Geometrické rovnice a diferenciálne rovnice rovnováhy platia pre ľubovoľný materiál, ktorý má vlastnosti 
spojitého kontinua. Boli odvodené nezávisle od seba a neobsahujú žiadne materiálové charakteristiky. Napätie, 
ako miera namáhania telesa, je však závislé od deformácie a že túto závislosť ovplyvňuje aj druh materiálu, nás 
presviedča experimentálna prax. Konštitutívne (fyzikálne, materiálové) rovnice slúžia na stanovenie tejto závislosti 
(konštituujú túto závislosť). Nie sú vo všeobecnosti odvodené od nejakých fyzikálnych princípov (aj keď musia 
spĺňať určité pravidlá - napr. musia byť objektívne, t.j. nezávislé od tuhého pohybu telesa v danom súradnicovom 
systéme); vyjadrujú v podstate len vlastnosti matematického modelu uvažovaného materiálu tak, aby vyhoveli 
experimentálnym údajom. 

     Existuje veľké množstvo materiálových modelov a s nimi spojených konštitutívnych rovníc, ktoré sa snažia 
simulovať rozličné reálne materiály pre rôzne typy stacionárneho i nestacionárneho namáhania. Mnoho 
materiálov vykazuje po určitú hranicu veľkosti zaťaženia lineárnu elastickú závislosť medzi deformáciou a napätím, 
ktorú možno vyjadriť vo forme zovšeobecnenia jednoosého Hookeovho zákona 

 ij ijkl klc=σ ε  (9.1) 

kde redukciou členov materiálového tenzora ijklc  možno vyjadriť všetky základné typy pružného lineárneho 

materiálu. Pod pružným materiálom sa rozumie taký materiál, ktorého deformácia vymizne, keď naň prestanú 
pôsobiť vonkajšie sily.  Napätie v zaťaženom telese s takto definovaným materiálom možno vyjadriť aj zo vzťahu 
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kde W je merná energia napätosti (deformačná energia akumulovaná v jednotke objemu), nazývaná tiež elastický 
potenciál alebo elastická potenciálová funkcia. Napr. pre jednoosý ťah izotropného materiálu dostávame 
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     V technickej praxi sa často využívajú aj nelineárne elastické materiály, ktoré sú pružné vo veľkom rozsahu 
deformácie, pričom ale závislosť napätia od deformácie je nelineárna (napr. technická guma, penové materiály, 
elastomérové kompozity, rôzne plasty, biomateriály). Vzhľadom na ich relatívne malú tuhosť a spôsob 
technického využitia sú úlohy s takýmto materiálom skoro vždy ešte aj geometricky nelineárne. Pokiaľ napätosť 
zaťaženého telesa z takéhoto materiálu nezávisí od zaťažovacej cesty, ale len od výsledného deformačného stavu, 
možno napätosť určovať z funkcie mernej energie napätosti W a hovoríme o hyperelastickom materiáli (obr. 1). 
Mnohé hyperelastické materiály majú vysokú hodnotu objemového modulu a často sa potom pri teoretickom 
spracovaní ich modelov považujú za nestlačiteľné (s nekonečne veľkou hodnotou objemového modulu, t.j. zmena 
hydrostatického tlaku nevyvolá žiadnu zmenu objemu takéhoto materiálu), prípadne takmer nestlačiteľné (tým sa 
myslí materiálový model, pri ktorom sa s ohľadom na numerické spracovanie pripúšťa malá hodnota 
stlačiteľnosti). 

 
Obr.1 Jednoosá charakteristika nelineárneho elastického materiálu 

     Základným krokom tvorby hyperelastického materiálového modelu je návrh skalárneho potenciálu W , ktorý je 
funkciou vhodnej miery deformácie [D3], najčastejšie deformačného gradientu F, pravého resp. ľavého Cauchy- 
Greenovho tenzora deformácie C resp. b, prípadne hlavných natiahnutí 1 2 3, ,λ λ λ  určených spektrálnou 

dekompozíciou U, resp. V.  



Pre deformačný gradient a jeho Jacobián platí 

 det( )J
∂ ∂

= = + =
∂ ∂

x u
F I F

X X
 (9.3) 

Pravý a ľavý Cauchy-Greenov tenzor deformácie sú 

 T T= =C F F b FF  (9.4) 

      Ak uvažujeme hyperelastický materiál, tak potom miera napätia materiálovej častice X zaťaženého telesa 
závisí len od aktuálneho deformačného gradientu  F  tejto častice. Pretože energeticky konjugovaným partnerom  
F  je prvé Piola-Kirchhoffovo napätie P  platí 

 ( )( ),=P P F X X  (9.5) 

Ak sa nám za pomoci experimentu podarilo pre daný materiál vyjadriť  elastický potenciál W potom analogicky s 
(9.2) možno napísať 

 ( ) ( )( ),
( ), PW∂

=
∂
F X X

P F X X
F

 (9.6) 

     Potenciál W i závislosť napäťových mier na tejto funkcii možno modifikovať podľa vzťahov, ktoré sme uviedli v 
[D3] a [D4]. Napr. z požiadavky objektívnosti konštitutívnych vzťahov vyplýva, že W je na F  závislé len cez jeho 
zložku natiahnutia U  a nezávislé na zložke rotácie R , a pretože pre pravý Cauchy-Greenov tenzor deformácie 

platí 2 T= =C U F F , možno napísať 
 ( ) ( )( ), ( ),PW W=F X X C X X  (9.7) 

Pre prírastok Green Lagrangeovho tenzora deformácie Eɺ , ktorý je energeticky združený s druhým Piola-

Kirchhoffovým tenzorom napätia S , platí 1
2=E Cɺɺ , dostávame analogicky s (9.6) tiež 
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Ak má hyperelastický materiál izotropné vlastnosti, potom vzťah medzi jeho potenciálom a C je nezávislý od  
materiálových osí a musí byť funkciou invariantov tenzora C   

 ( ) ( )( ), , , ,C C CW W I II III=C X X X  (9.9) 

kde 
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a pre druhé Piola-Kirchhoffovo napätie podľa (9.8) a (9.9) možno napísať 
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kde sa uplatnili derivácie invariantov podľa zložiek  tenzora C  [Lit1] 
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Invarianty C a b sú identické 
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z čoho tiež vyplýva, že derivácie W podľa invariantov C  v (9.11) sú tiež deriváciami W  podľa invariantov b. 

     Cauchyho napätie možno určiť z druhého Piola-Kirchhoffovho napätia pomocou transformačného vzťahu [D4] 

 1 TJ−
FSFσ =σ =σ =σ =  (9.13) 



Keď do tohto vzťahu dosadíme (9.11) dostaneme 
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     Uvedené rovnice platia pre všeobecný izotropný hyperelastický materiálový model. Ich využitie si ukážeme na 
relatívne jednoduchom modeli tzv. stlačiteľného Neo-Hookeovského materiálu. Názov dostal podľa toho, že zápis 
jeho charakteristík (Eulerovského tenzoru deformácie) je analogický so zápisom charakteristík klasického 
lineárneho izotropného Hookeovského materiálu. Stlačiteľný Neo-Hookeovský model je definovaný potenciálovou 

funkciou (existuje však aj viacero alternatívnych zápisov, najmä pri použiti *
CII  v (9.10)) 

 2( 3) ln (ln )
2 2CW I G J J
Μ Λ

= − − +  (9.15) 

kde Μ  a Λ  sú materiálové konštanty. Všimnime si, že funkcia okrem základného predpokladu objektívnosti (je 

funkciou invariantov CI  a CIII J= ) spĺňa aj ďalší nevyhnutný predpoklad, že pri nulovej deformácii je elastická 

potenciálna energia W nulová ( =C I , 3CI = , det 1=F , ln 0J = ). 

     Druhý Piola-Kirchhoffov tenzor deformácie teraz už môžeme vyjadriť z rovnice (9.11) 

 1 1( ) (ln )J− −= Μ − + ΛS I C C  (9.16) 

a Cauchyho napätie z (9.14) pomocou zložiek ľavého Cauchy-Greenovho tenzora b 

 ( ) (ln )J
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− +b I Iσ =σ =σ =σ =  (9.17) 

Ak budeme uvažovať jednoosý ťah bez priečnej deformácie, potom  
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a z (9.17) dostávame 

 2( 1) lnxσ λ λ
λ λ
Μ Λ

= − +  

Pre prút s jednotkovou dĺžkou, s Μ = 100 Pa a Λ = 1000 Pa, sme priebeh xσ  graficky znázornili na obr. 1 pre 

najčastejšie využívaný rozsah deformácie tohto materiálového modelu. Spôsob identifikácie reálneho materiálu s 
týmto modelom (i ďalšími hyperelastickými materiálovými modelmi) možno nájsť v manuáloch komerčných 
programov MKP. 

Mi = 100.;

La = 1000.;

L = 1.;

lambda = 1. + dL � L;

sigma = Mi Hlambda^2 - 1.L � lambda + La * Log@lambdaD � lambda;

Plot@sigma, 8dL, -0.3, 0.3<,

PlotStyle ® 8Thickness@0.005D<, AxesLabel ® 8deltaL, sigmaX<D
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Obr. 1 



     Iný jednoduchý prípad je zaťaženie všestranným (hydrostatickým) tlakom, kedy 
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Vtedy podľa  (9.17) dostávame 
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čo predstavuje zaťaženie  
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Závislosť tlaku/ťahu p na natiahnutí λ  je znázornená na obr. 2 (všestranný ťah je len ilustračná záležitosť) 

Mi = 100.;

La = 1000.;

L = 1.;

lambda = 1. + dL � L;

pp = HMi Hlambda^2 - 1.L + La * Log@lambda^3DL � lambda^3;

Plot@pp, 8dL, -0.2, 0.3<, PlotStyle ® 8Thickness@0.005D<, AxesLabel ® 8deltaL, p<D
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Obr. 2 

     Pri práci s nestlačiteľnými alebo takmer nestlačiteľnými materiálovými modelmi je potrebné oddeliť objemovú 
časť deformácie (ktorá mení len objem materiálovej častice) od distorznej (tvarovej, deviátorovej, ktorá mení len 
tvar častice, bez zmeny objemu). Pretože determinant deformačného gradientu udáva objemovú zmenu /dv dV , 

pre distorznú časť deformačného gradientu F
⌢

 potom musí platiť  

 det 1=F
⌢

 (9.18) 

Ak zvolíme 

 1 3 1 3
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⌢ ⌢

 (9.19) 

potom je táto podmienka splnená 
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Platnosť vzťahu medzi F  a F
⌢

 ilustruje číselný príklad na obr. 3. Analogicky možno rozložiť aj ďalšie tenzorové 
miery deformácie. Napr. pre distorznú zložku pravého Cauchy-Greenovho tenzora deformácie a jeho prvý 
invariant platí 

 1/3 2/3 2/3(det )T
C bJ I I tr J tr− − −= = = = = =C F F C C C C C

⌢ ⌢⌢ ⌢ ⌢ ⌢
 (9.20) 

 



F = 881.5, -1.2, 0<,

82.6, 2.0, 0<,

80, 0, 1<<;

Print@"F = ", F �� MatrixFormD

J = Det@FD;

Print@"J = detF = ", JD

pom = Det@J^H-1 � 3L * FD;

Print@"detF’ = det@J^H-1�3L*FD = ", pomD

F =

1.5 -1.2 0

2.6 2. 0

0 0 1

J = detF = 6.12

detF’ = det@J^H-1�3L*FD = 1.  

Obr. 3 

     Pri nestlačiteľnom Neo-Hookeovskom modeli  sa elastický potenciál (9.15) zjednoduší na 

 ( 3)
2

W tr
Μ

= −C
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 (9.21) 

pravda, z úplnej nestlačiteľnosti materiálu vyplývajú aj niektoré výpočtové nepríjemnosti. Pri úplne nestlačiteľnom 
materiáli hydrostatický tlak ( / 3kkp σ= ) ľubovoľnej hodnoty nespôsobí zmenu tvaru telesa, takže napätie nie je 

možné jednoznačne určiť z jeho deformácie. Z konštitutívnych rovníc možno určiť len deviatorické napätie 
/ 3ij kk ijσ σ σ δ= −′ . Tlak p , ktorý sa objaví v konštitutívnych rovniciach, je nutné určovať ako ďalšiu primárnu 

neznámu úlohy z podmienok rovnováhy a okrajových podmienok. Pre nestlačiteľný Neo-Hookeovský materiál 
rovnica (9.17) sa zmení na 

 5 3 1
3( )bp J I p

−+ = Μ − +′ I b I Iσ = σσ = σσ = σσ = σ  (9.22) 

kde opäť paltí b CI I tr= = C . 

     V MKP sa problém s neznámou p často rieši pomocou tzv. takmer nestlačiteľných materiálových modelov. 
Postupuje sa tak, že k distorznej zložke potenciálu sa na umožnenie malej objemovej deformácie pridáva 
objemová energetická zložka ( )U J  na vytvorenie totálneho potenciálu v tvare 

 21
( ) ( ) ( ) ( 3) ( 1)

2 2
W W U J tr J
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kde sme zaviedli jednoduchý príklad takejto zložky  

 21
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     Pri nestlačiteľných materiáloch sa Κ  volí ako veľký násobok Μ  (103 až  104 Μ ). S touto materiálovou 
konštantou sa možno stretnúť aj pri stlačiteľných hyperelastických materiálových modeloch, keď sa uvažuje 
energetický potenciál v tvare (9.23). Vtedy Κ  predstavuje objemový modul materiálu (pozri napr. Neo-
Hookeovský model v teoretickom manuáli ANSYSu). Pri takejto voľbe U, potom Cauchyho napätie pre Neo-
Hookeovský materiálový model podľa (9.22) je 

 5 3 1
3( ) ( 1)bJ I J

−Μ − + Κ −b I Iσ =σ =σ =σ =  (9.25) 

     Konštitutívne rovnice izotropného hyperelastického materiálu sa často vyjadrujú aj pomocou hlavných 
natiahnutí 1 2 3, ,λ λ λ  a hlavných smerov 1 2 3, ,N N N   

 
N N Ii

i
i⊗ =

=
∑
1

3

 (9.26) 

Je to výhodné najmä vzhľadom na experimentálne určovanie materiálových konštánt modelu. Spektrálna 
reprezentácia pravého Cauchy - Greenovho tenzora deformácie a jeho inverzie pomocou týchto veličín je [D3] 
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Pretože 1 2 3, ,λ λ λ  sú vlastné čísla tenzora C , jeho invarianty možno vyjadriť tiež v tvare 
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a využívať ich pri vyjadrovaní funkcií elastického potenciálu W rovnako ako (9.10). Z podmienky (9.19) pre 
distorzné hlavné natiahnutia vyplýva 

 1 3
i iJλ λ−=
⌢

 (9.30) 

a pre nestlačiteľný materiál tiež platí 
 3 det det 1I = = =C b  (9.31) 

takže distorzná (nestlačiteľná) časť elastického potenciálu obsahuje len dva distorzné invarianty 

 2/3 4/3
1 1 2 2I J I I J I− −= =
⌢ ⌢

 (9.32) 

     Elastický potenciál často využívaného Mooney-Rivlinovho materiálového modelu v takmer nestlačiteľnej 
formulácii možno potom zapísať v tvare 
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kde pqC  a mD  sú materiálové konštanty. Konštanty pqC  vyjadrujú distorzné (šmykové) vlastnosti modelu a mD   

udávajú stlačiteľnosť t.j. objemovú zmenu tohto materiálového modelu. Ak konštanty mD  sa rovnajú nule, ide o 

úplne nestlačiteľný materiál. 

     V odbornej literatúre týkajúcej sa hyperelasticity a v manuáloch komerčných programov MKP možno nájsť 
množstvo hyperelastických materiálových modelov vychádzajúcich z rôzne definovaných elastických potenciálov 
tvorených z invariantov mier deformácie analogickým postupom, ako sme tu naznačili. Pre záujemcov o 
programové spracovanie úloh s hyperelastickou deformáciou možno odporučiť voľne stiahnuteľný fortranovský 
program  FLagSHyP (Finite element Large Strain Hyperelasto-plastic Program) opísaný v práci [Lit1]. 

 
Príklad  

     Pomocou programu FLagSHyP sme riešili ilustračný príklad rovinnej napätosti telesa obdĺžnikového tvaru s 
rozmermi 6 x 3 a hrúbkou 0,1, ktorého sieť štvoruzlových prvkov je znázornená na obr. 4. Teleso je na ľavej hrane 
pevne votknuté a pravá hrana sa posunie o hodnotu 2,5 podľa obrázku, pričom sa zabraňuje jej priečnej 
deformácii a strate stability telesa. Materiál telesa je nestlačiteľný Neo-Hookeov (9.21) s konštantou 100Μ = . 
Vstupné údaje sú uvedené v prílohe. Do programu sme vložili podprogram, ktorý z číselných výsledkov vytvoril 
postscriptovský súbor na zobrazenie zdeformovanej siete prvkov s výsledkom na obr. 5.    
 
 

 
 

Obr.4  



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obr. 5 
 
     Ten istý príklad sme riešili aj pomocou programu ANSYS s touto postupnosťou príkazov v interaktívnom móde: 
 
1. Zadanie názvu úlohy 
Utility Menu>File>Change Jobname..., /FILNAM = GUMA, OK; 
 

2. Typ prvkov a ich hrúbka 
Main Menu>Preprocessor>Element Type>Add/Edit/Delete,  Add..., Hyperelastic 4 node 182, OK, Options…, K3 = 

Plane strs w/thk, OK, Close; 
Main Menu>Preprocessor>Real Constants>Add, Edit, Delete, Add..., OK,  THK = 0.1, OK 
 

3. Materiálové údaje 
Preprocessor>Material Props>Material Model Number 1, Structural, Nonlinear,Elastic, Hyperelastic, Neo-Hookean, 

mu = 100,  d = 0, OK, Material, Exit; 
 

4. Vytvorenie bodov strednicovej plochy modelu (číslovanie je automatické) 
Preprocessor>Modeling>Create>Areas>Rectangle>By 2 Corners↑:  Width = 6, Height = 3, OK; 
 

5. Vytvorenie prvkov  
Preprocessor>Meshing>Size Cntrls>ManualSize>Global>Size: Size = 1, OK; 
Preprocessor>Meshing>Mesh>Areas>Maped>3 or 4 sided: Pick All; 
 

6. Upevnenie modelu a predpísanie posunutia pravej hrany modelu 
Main Menu>Solution>Define Loads>Apply>Structural>Displacement>On Lines: ↑ľavú hranu, OK, Vyznačiť All DOF, 

Apply,↑pravú hranu, Apply, Vyznačiť UY, Apply, ↑pravú hranu, OK, Vyznačiť UX, VALUE = -2.5, OK; 
 

7. Zapnutie veľkých deformácií 
Solution>Analysis Type>Sol'n Controls: Analysis Options = Large Displacement Static, Time at end of loadstep = 

1,OK; 
 
8. Príkaz na vykonanie výpočtu  
Solution>Solve>Current LS, Solve Current Load Step, OK; 
 

9. Vykreslenie zdeformovanej siete 
Main Menu>General Postproc>Plot Results>Contour Plot>Nodal Solu: DOF Solution, X-Component of 

displacement, Deformed shape with undeformed model, OK; 
 



 
 

10. Ukončenie práce s uložením databázy úlohy 
Ansys Toolbar>Quit>Save Geom+Loads, OK; 

Literatúra 
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Príloha - Vstupné údaje príkladu do programu FLagSHyP: 
 

Priklad Guma 
quad4 
28 
1  3 0. 0. 
2  3 0. 1. 
3  3 0. 2. 
4  3 0. 3. 
5  0 1. 0. 
6  0 1. 1. 
7  0 1. 2. 
8  0 1. 3. 
9  0 2. 0. 
10 0 2. 1. 
11 0 2. 2. 
12 0 2. 3. 
13 0 3. 0. 
14 0 3. 1. 
15 0 3. 2. 
16 0 3. 3. 
17 0 4. 0. 
18 0 4. 1. 
19 0 4. 2. 
20 0 4. 3. 
21 0 5. 0. 
22 0 5. 1. 
23 0 5. 2. 
24 0 5. 3. 
25 3 6. 0.  
26 3 6. 1. 
27 3 6. 2.  
28 3 6. 3. (pokrač. hore) 

18 
1 1 1 5 6 2 
2 1 2 6 7 3 
3 1 3 7 8 4 
4 1 5 9 10 6 
5 1 6 10 11 7 
6 1 7 11 12 8 
7 1 9 13 14 10 
8 1 10 14 15 11 
9 1 11 15 16 12 
10 1 13 17 18 14 
11 1 18 19 15 14 
12 1 15 19 20 16 
13 1 17 21 22 18 
14 1 18 22 23 19 
15 1 19 23 24 20 
16 1 21 25 26 22  
17 1 22 26 27 23 
18 1 23 27 28 24 
1 
1 6 
1. 100. 0.1 
0 4 0 0 0 
25 1 -2.5 
26 1 -2.5 
27 1 -2.5 
28 1 -2.5 
10 1. 0.1 30 1.e-6 0. 0. 5 

 
 

 


